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OVERVIEW

This document is a guide for building energy performance
simulation beginners. Its focus audience are designers interested
In studying the effect of early design decisions such a orientation,
shape and facade layout on the energy efficiency of their projects.
Throughout the document we will be using DesignBuilder/
EnergyPlus as our simulation tool. The document will teach you

how to:

Set up DesignBuilder on your WINDOWS™ PC;
Build and maintain a simple model in DesignBuilder;
Carry out a heating and cooling load analysis of the

model and calculate its annual energy use for heating,
lighting and cooling.
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OVERVIEW

Building Energy Performance Simulation

@ A buildings is a complex thermodynamic object that
accommodates constantly changing energy flows between the
different thermal zones within the building and the outside.

@ The two main components of the building energy simulation model
are the building fabric and content (walls, floors, ceilings,

occupants and equipment) and the plant components (HAVC
equipment and other environmental control systems).

@ Due to the complexity of a building model, computer simulations
can analyze the effects of different ECMs (Energy Conservation
Measures) and their complex interactions more efficiently,
comprehensively and accurately that any other available method.*

INFO

1- M Kaplan and P Caner, Guidelines for Energy Simulation of Commercial Buildings.
Report for Bonneville Power Administration (DE-FC79-85BP26683). 1992.
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OVERVIEW

Simulation Engine vs. GUI

@ Most building energy simulation programs come with a graphical
user interface (GUI) as well as the actual simulation engine. The
former is used to prepare simulation input files for the latter and to
display simulation results once a simulation is complete.

@ The developers of simulation engines and GUIs often work for
different companies with the engine being developed at public
organizations (government lab & universities) whereas GUIs are
more often developed by commercial vendors. As a result there
can be several GUIs for the same simulation engine.

8 While the choice of GUI determines the ease of use if a simulation
program, it is ultimately the engine that determines how reliable
simulation results are. A great GUI with a weak engine cannot yield
reliable results!
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OVERVIEW

We will be using EnergyPlus as the simulation engine

@ EnergyPlus is the U.S. Departments of Energy’s 3™ generation
dynamic building energy simulation engine for modeling building,
heating, cooling, lighting, ventilating and other energy flows.2

@ The program was developed during the nineties and is an
amalgamation of the BLAST and DOE-2 simulation engines. Apart
from energy use, the program can be used for load calculations
and to model natural ventilation, photovoltaic systems, thermal
comfort, water use, green roofs and other ECMs.

g INFO

EnergyPlus can be downloaded from www.eere.energy.gov/buildings/energyplus/. The program
comes with ample documentations but without a GUI. EnergyPlus’ capabilities are constantly being
further expanded so that more recent modules might not be accessible through any GUI. As a
result advanced users often start editing their models manually using a text editor. Once any

\_ manual changes have been made to a model one usually cannot go back to the GUI. Yy,
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OVERVIEW

Other reasons for using EnergyPlus

@ ltis a ‘Qualified Computer Software’ for Calculating Energy
Savings for Purposes of the Energy-Efficient Commercial Building
Tax Deduction under Internal Revenue Code §179D.

@ Expert users can get access to the source code allowing for third-
party validation which adds to the software’s credibility and long
term reliabllity.

@ EnergyPlus has been validated under the comparative Standard
Method of Test for the Evaluation of Building Energy Analysis
Computer Programs BESTEST/ASHARE STD 140. INE

(

To find a list of qualified computer software for calculating commercial building energy and power cost
savings that meet federal tax incentive requirements under Internal Revenue Service (IRS) go to:
http://www1.eere.energy.gov/buildings/qualified_software.html

The BESTEST (Building Energy Simulation TEST) is a comparative set of tests which has become one of the
industry’s most accepted methods to validate and test the simulation capabilities of the exterior envelope
kportions of building energy simulation programs. More information at http://gundog.lbl.gov/dirpubs/rio4.pdf )
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OVERVIEW
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Energy Plus’
Integrated Solution Manager Building Description Doscrve
By using an integrated solution
technique, EnergyPlus overcomes EnergyPlus
the most serious deficiency of the Al gl
BLAST and DOE-2 sequential v | '
simulations— inaccurate space windows |~ Heatand | Third-Party
c c Calcs Mass [ BUIIdlng User
temperature predication due to no |,:I._|irf.(,\,.,rk Balance | Systems |_Pcl;:lludtic:n Interfaces
etwo : ) | o o odels
tne loads caloultions, Accurate  [ESERES MU ton ST o
Transfer Zone
Jags calcUiations. AcCUrate e ——
prediction of space temperatures is Upiate
crucial to energy efficient system [l b ==
engineering, occupant comfort, e bl Display
occupant health, system size, plant =
size.

Source: D.B. Crawley et al. / Energy and Buildings 33 (2001) 319+331, and Getting Started with Energy Plus, (2007).

INFO

Loads calculated (by the heat and mass balance engine) are passed to the building systems simulation module.
The building systems simulation module calculates heating and cooling system and plant and electrical system
response. Feedback from the building systems simulation module on loads not met is reflected in the next time
step of the load calculations in adjusted space temperatures if necessary, and not just reported as unmet hours.
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OVERVIEW

Choosing a GUI for EnergyPlus?
Goa.}g[e

SketchUp

DesignBuilder

SOFTWARE

EnergyPlus

Simulation engine | Graphical User Interfaces |NFQ

A number of GUIs are currently available for EnergyPlus. Among those GUIs Ecotect, Google Sketchup
(Energy Design Plug-in) and DesignBuilder mare specifically geared towards users with a background in
design as opposed to engineering. A list of all the available GUIs for EnergyPlus can be found at:
http://www.eere.energy.gov/buildings/energyplus/
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OVERVIEW

Why DesignBuilder?

@ We chose DesignBuilder the tool for this tutorial as we
found it to be a mature product which offers flexible

geometry input and extensive material libraries and load
profiles.

@ EnergyPlus is integrated within DesignBuilder’s
environment which allows you to carry out complete
simulations without leaving the interface.

NEO

When bringing whole-building performance simulation closer to designers it is key to make the
process of setting up a model and populating it with technical data as simple as possible without
compromising accuracy or rigor. Reliable data templates of libraries and components (constructions,
materials, schedules, HVAC system, activity profiles, etc) are extremely important in this process as
kthey help designers set up their models in a comprehensive and transparent way. Y

~
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OVERVIEW

Why DesignBuilder?

@ Simulation results can be effectively displayed and
analyzed. simulation data in a comprehensive manner.

@ DesignBuilder has quality control procedures which assure
the accuracy of the results in comparison the stand-alone
EnergyPlus engine. e.g. As EnergyPlus, it has been
tested under the comparative Standard Method
BESTEST/ASHARE STD 140.
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OVERVIEW

Software Limitations

8 An advanced user might find the EnergyPlus simulation
capabilities that are accessible form the DesignBuilder GUI
limiting. In this case a user can export a DesignBuilder
model into EnergyPlus ASCII files. Unfortunately, it is

currently not possible to import a modified model back into
DesignBuilder.

@ There are limitation for inputting complex geometry (e.g.
geometries defined through smooth functions / free forms)




Harvard Universily
Graduate School of Design version: 9/30/2009

INDEX

® SET-UP

® BUILDING A MODEL

® RUN A SIMULATION

® ANALYZE RESULTS

INFO

It is recommended that you work through the four sections in the order provided. Further information
can be accessed through// links /distributed throughout the text.
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SET - UP

Follow the instructions outlined below to set-up your computer.

Make sure to pay close attention to all the steps and execute them
carefully.

P Res e | DesignBuilderm)

You may download a FREE 30-day evaluation version of the latest
DesignBuilder version from the ‘DesignBuilder Software’ website. This

document is based on DesignBuilder v.1.6.2.0004 BETA (release date:
07/31/08).

http://www.designbuilder.co.uk

INFO

DesignBuilder Software requires you to provide some general information about yourself before you
can download the evaluation version. You must be logged in before attempting to download. If you do
not have a login and password, you will have to register first.
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SET - UP

If you have a previous version of DesignBuilder installed you must first
uninstall it from the Windows Control Panel>> ‘Add or remove programs’
before installing a new version. DesignBuilder is designed for Windows
Vista, Windows XP SP2 and Windows 2000. Windows 95, 98, ME, NT are
not supported.

The file you have to download is a .EXE file. Save it into any folder on your
PC and double click on it. Follow the on-screen instructions. The complete
Installation takes about one or two minutes. You may delete the file after the
Installation is completed.

Folder directory preferences: It is recommended that you use the default
DesignBuilder installation location on your PC which is C:\ Program
Files\DesignBuilder (see note below).

INFO

You must be logged on with Administrator privileges to the machine on which you are installing
DesignBuilder. Otherwise you will receive error messages during installation and the software will not
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SET - UP

When using DesignBuilder with Windows Vista you should ensure that
Windows XP SP2 compatibility has been set. You should also check the
'‘Disable desktop composition' to switch off the 'Aero’ interface effect.
Without these changes the DesignBuilder screen does not refresh correctly.
These settings need to be changed before you run DesignBuilder for the
first time. (see note below)

Many of the early graphics adapter drivers written for Vista have bugs
preventing DesignBuilder from loading at all. It is recommended you
upgrade your graphic adapter drivers.

INFO

To set DesignBuilder to run in compatibility for Windows XP SP2, right click on the DesignBuilder icon from the
start menu and select "Properties”. Then click on the Compatibility tab and check "Run this program in
compatibility mode for:" and select Windows XP SP2 if it is not already set. Also check the 'Disable desktop
composition' to switch off the 'Aero’ interface effect. Many recent ATI Radeon graphics cards are not compatible
with DesignBuilder because of OpenGL compatibility issues. More information about compatibility related
Q)roblems can be found at http://www.designbuilder.co.uk )
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SET - UP

K=s |[EnergyPlus |

The EnergyPlus dynamic simulation engines is completely
Integrated into DesignBuilder and there is no need to install it
separately. When you install DesignBuilder, the installation
package installs EnergyPlus automatically into a folder under the
same directory. e.g. C:\ Program Files\ DesignBuilder\EnergyPIus.

s Py ] LATION =

This document is based on DesignBuilder
¥ - 48 v.1.6.2.0004 BETA (07/31/08), which works
fdiiss With EnergyPlusv2.2.0.025 engine.

NEO

With time, as you become an more advanced user you may want to install EnergyPlus separately to

review the files in detail in a text based option with EnergyPlus’ IDF editor. In that case you can
download EnergyPlus from http://www.eere.energy.gov/buildings/energyplus/




Harvard Universily
Graduate School of Design version: 9/30/2009

SET - UP

Customizing DesignBuilder - Selecting a Unit System

DesignBuilder can be used with either metric (Sl) or imperial
(IP) units. Because the most databases that come with the
program were originally configured in Sl units, IP users may
find of some of the default assumptions awkward. For
example, even thought the glazing’s U-values are displayed in
(Btu/h*ft2*F), the names and decryptions associated with
every glazing are still displayed in mm.
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SET - UP

Customizing DesignBuilder - Selecting a Unit System

The first time you run DesignBuilder a window will pop up asking
you which UNIT SYSTEM you want to use: IP (Inch-Pound) or Sl
(International System). For the purpose of this document, to the
guestion: “Do you want to use IP Units?” Click “NO”.

DesignBuilder

<P Do ywou wank to use [P units

X

You can switch between IP and ST units at any time on the 'Tnternational’ tab on the Program Options dialog

-

INFO

As the pop up window states, you can later switch between IP and Sl units at any time. (In the next page
you can see how to switch between Sl and IP units).
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Customizing DesignBuilder - Selecting a Unit System

1 Des' |nBuilder

Help

To switch between Sl and IP
[

e, units go to “Tools” > “Program
' Options”

b Zone vs System Plenums Example
iy Solar Chimney Example

sy Trombe Wall Example

&t Courtyard with VAY Example

& House Example 1

it Atrium Example with Calc Nat Vent
it Mech Vent with Preheat

ity Underfloor Healing Example

(L Survey Example

4 Single Zone Example

ity House Example 2

(i Model Geometry Example

Under “Units” you find:
1-Metric (SI) and
2-Inch-Pound (IP)




Harvard Universily
Graduate School of Design version: 9/30/2009

BUILDING A MODEL

Now that you have downloaded and installed DesignBuilder/
EnergyPlus, follow the steps outlined below to learn how to build a

simple model and to carry out a building energy performance
simulation.

At the end of this section you should be able to:

@ Understand the basis of DesignBuilder’s user
Interface and it's data organization model

@ Build a simple model

INFO

Please finish reading this whole section before you go on and watch the DesignBuilder online tutorials.
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BUILDING A MODEL

We suggest you first work through Tutorial #1 (User Interface) on
the DesignBuilder website. The tutorial is an excellent way to
familiarize yourself with the interface and its capabilities. Follow

each step carefully as we will continue to work on the file you create
In Tutorial #1.

) TUTORIAL #1
Tutorial number one will introduce you to the overall layout
of the GUI and to the construction of building models. It
shows you how to create a new project, describes the

basic drawing tools and briefly talks about data hierarchies
within EnergyPlus.

INFO

Please review the next 4 slides before you work through Tutorial #1.
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BUILDING A MODEL

DesignBuilder Software has made these tutorials available online.
You can either watch them online or download them to your
computer to watch them offline.

@ To watch them online, launch DesignBuilder, from the
WINDOWS™ ‘START’ menu, choose ‘PROGRAMS’ >
‘DesignBuilder’ > ‘DesignBuilder’, then click in the link
“web tutorials” that you will find at the center right of your
screen under “other tools”. This will launch your web
browser directly to the tutorial’s page.

@ To download the tutorials go to DesignBuilder’s webpage:
http://www.designbuilder.co.uk, then to “Downloads” and
then “Tutorial”.
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BUILDING A MODEL

Please note that the tutorials are based on an older version of
DesignBuilder. This will make your model and screen look slightly
different than the ones shown in the tutorial. The older versions of
DesignBuilder have less options in the menus and tabs and have
different default templates. For example, the default value for wall
openings was changed from 30% to 40% in version 1.6.004.

@ Itis important that you keep all of the defaults as set in
your current version and that you only modify the
elements or parameters mentioned in the Tutorial.
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BUILDING A MODEL

Selecting a Template

1.

When asked to modify =38 i
the “Activity” of the aen
meeting room located in i h
the “Ground floor”, click
in the “browse” tab to
select a different activity
template.

2.

Under the ‘Select activity
template’ menu, choose

‘Workday prol

the most appropriate

Schedules

INFO

Note that templates (activity, schedules, constructions, etc., might vary between different versions.

template for the space. i.e.
‘Office_MeetRm’.
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BUILDING A MODEL

File  Edit ools  Help

I n p U ttl n g G e O m etry [T DesignBuilder - umiuef _1.dsh -Layout - Tutorial 1, Building 1

Lighting &

Once you are finished with
Tutorial #1, you should have a
model that looks similar to this:

Z =0.000m

‘Edit’ Tab

‘Visualize’ Tab

INFO

Please start with Tutorial #1 now.
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BUILDING A MODEL

MODEL DATA HIERARCHY & DATA INHERITANCE

Now that you have watched Tutorial
#1 and familiarized yourself with " site
the interface, we will further explain

; | N\
some key aspects of how data input j

Is organized in DesignBuilder / €+

Block
DesignBuilder, same as €+, follows a ‘model N\
data hierarchy’. DesignBuilder further uses g
‘data inheritance’ through categories Ny
allowing you to automatically populate sub- @
categories. This way information is passed ) N\
automatically from higher category levels to @

lower category level making data input
faster and more reliable (see the next slide).
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BUILDING A MODEL

Default data is inherited
from the level above in the
hierarchy, so block data is
Inherited from building
level, zone data is
Inherited from block data
and surface data from
zone data. When you
change a setting for a
category this change is
‘inherited’ by all lower
levels within the category. |

This arrangement allows you to either make settings at the building or block level. A selection for a
wall type at the building level will affect all walls within the building whereas a selection at the block
level will only affect the walls within that particular block.
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BUILDING A MODEL

=S

\y
Construction and window- B“’ldm\g
to-wall-ratios default | N _
values are inherited down N
to the surface level where N
the data is actually used
in the calculations. é
[opeiss
Data from S _

INF

(" For example, it is the External wall construction model data at the surface level that defines the construction
used for that external wall. The External wall model data set at zone, block and building level has no effect
on the model (other than providing a default values for lower lying levels).

Most data at the building level is “user data” as buildings do not inherit their data from the site level. All
\ openings inherit their data from the surface level. y

i
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BUILDING A MODEL

MODEL DATA HIERARCHY & DATA INHERITANCE

C

SURFACEa [l SURFACEa Bl SURFACEa [ SURFACEDL " SURFACED |
| |
|

OPENING a oPeNING a |l OPENING b [ (IBPERT

=
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SIMULATION

Now that you know how to build a simple model, we suggest that
you work through Tutorial #2 (Simulations). We will afterwards
review your simulation results from the tutorial with you.

@ TUTORIAL #2
Tutorial number two will show you how to run design
calculations for winter and summer design conditions
and how to carry out an annual simulation using typical
weather data for your site. The latter provides an
estimate of a building‘s overall annual fuel consumption.

INFO

The following slides provide additional informationabout simulation basics and additional settings.
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version: 9/30/2009

Heating Design Calculation

A heating design calculation is performed to investigate a
building’s behavior under extreme weather conditions.
Calculation results are typically used to size heating
systems and their components.

INFO

The weather conditions used during a heating design calculation are set according to the building location. The
designer may select the "severity" of weather that he or she deems appropriate. Typical heating design
temperatures lie in the 99" or 99.6™ percentile of all temperatures that typical occur at a site throughout the
year, i.e. 99% or 99.6% of the time it is warmer than the heating design temperature.

Heating design calculations are carried out under Steady State (SS) conditions (stable temperatures over a
several-hour period), which means that thermal mass effects are ignored. The calculations assume worst case
conditions including no solar gains, no internal gains (lighting, equipment, occupancy, etc) and design conditions
for wind speed and direction. The resulting “design heat loss” (the sum of all heat flows out of a building) is
further multiplied by a “sizing factor” to determine the “design heating load” (the capacity of heating equipment
required to offset all heat losses). See also ASHRAE Handbook of Fundamentals, 2001 (ISBN 1-883413-87-7)

QZ.ZQ
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SIMULATION

Setting the Heating Design Temperature

1.

Go to the “edit” tab go to “Site” level FERIS
> “Location” > “Winter Design %
Weather Data”. o '

lt"-TBmplalB LONDON/GATWICK ARPT

You may select a "severity" of
heating design weather (winter
conditions) that seems appropriate
to your project. As a result you will
see which design temperatures are
used by the calculation.

- a 99% design temperature is one
that will be exceeded, statistically
speaking, for 88 hours in a typical
year

- 2 99.6% design temperature is
one that will be exceeded,
statistically speaking, for 35 hours
in a typical year.

|| Simulation
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SIMULATION

Sizing Factor
2.

Select a “Design margin” for the
heating system of “1.8".

The Heating Design margin is
used to multiply calculated steady
state heating loads in each zone to
give a recommended heating plant
size. It accounts for the additional
heat required to bring the building
up to temperature in a reasonably
short preheat period and allows
you to be confident that comfort
conditions will be maintained in all
but the most extreme winter
conditions.

Deszign margin

Loading data...

1-Air temperature

Calculation Options

version: 9/30/2009
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SIMULATION

Results of a Heating Design Calculation

3 " 1% DesignBuilder - Tutorial 1 DBv1.6.004.dsb - Layout - Tutorial 1, Building 1

Depending on the version of
DesignBuilder that you are
working with, your results will
vary from those in the tutorials. If
our are using version DB
v.1.6.2.0004 , your first
screenshot after performing the
heating design calculation should
look like this.

Tutorial # 2 will still show you a
simplified version of the results. It
will not display the table view and
will not display Relative Humidity
values (RH) or air changes rates
(ac/h). The results that you will
get will also vary from those in the
tutorial as you are not using the
exact same design parameters.
(This is a result of changed
default values in DesignBuilder.)
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SIMULATION

Cooling Design Calculations

Same as a heating design calculation, a cooling design
calculation is performed to investigate a building’s
behavior under extreme conditions, in this case cooling
conditions. The calculation results are typically used to
size HVAC systems and their components |

ﬂ)oling Design calculations are made to determine a building’s required cooling load needs. Cooling load is
the capacity of the equipment to account for all the heat gains of the building (external and internal) assuming
dynamic conditions. Dynamic temperature variations mean that heat storage occurring in the building
envelope and/or interior elements is considered (in DB, defined as default as half-hourly temperatures). As a
result cooling loads are often not equivalent to total heat gains. Cooling design calculations also assume
worst case conditions such as clear sky solar gains, full typical capacity internal gains (lighting, equipment,
occupancy, etc) and no wind. DesignBuilder however allows you to consider scheduled natural ventilation.
Weather conditions for “cooling design calculations follow the same criteria as for “heating design
calculations” and will not necessary represent any actual year, and the designer may select the "severity" of
weather that he or she deems appropriate. The resulting maximum cooling load in each zone is multiplied by
a “Design Margin” to give a “Design Cooling Capacity” (the capacity of equipment required to offset such a
@d). More information about Cooling Design Calculations can be found in ASHRAE Handbook of /

Fundamentals, 2001 (ISBN 1-883413-87-7) TC.29
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SIMULATION

TUTORIAL #2 The Basis of Cooling Design Calculations

When carrying out cooling design calculations in zones which
are not mechanically cooled free-floating temperatures are
calculated and may include the effects of natural or
mechanical ventilation.

This is the case of the first cooling design calculation in tutorial
#2, when you will first see free-floating temperatures as a
result of not having mechanical cooling activated by default.
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Setting the Cooling Design Temperature

1.

Go to the “edit” tab then to “Site”
level > “Location” > “Summer
Design Weather Data”.

You may select a "severity" of
cooling design weather (summer
conditions) that seems appropriate
to your project. As a result you will
see which design temperatures are

going to be used by the calculation.

- a 99% design temperature is one
that will be exceeded, statistically
speaking, for 88 hours in a typical
year

- a 99.6% design temperature is
one that will be exceeded,
statistically speaking, for 35 hours
in a typical year.

12 DesignBuilder - Tutorial 2 DBv1.6.dsb - Location - Tutorial 2

version: 9/30/2009

LONDON/GATWICK ARPT
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SIMULATION

Safety Factor
2.

Go to the “Site” level > then to
the “Cooling Design” tab.

The Cooling Design margin is a
'safety factor' used to multiply
calculated cooling loads in each
zone to give a recommended
maximum cooling equipment
capacity. It accounts for the
additional cooling required to
cool the building within a
reasonably time period and
allows you to be confident that
comfort conditions will be
maintained in all but the most
extreme summer conditions
(risk depends on the Summer
Design Weather Data options
selected at site level). For this
exercise please keep the
default value.

gn | Simulation
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SIMULATION

Cooling Design Calculation
3.

Due to the version you are working
on, your results will vary compared
to the ones in the tutorials. Your first
screenshot after performing the
heating design calculation should
similar to this (if you are using
version DB v.1.6.2.0004).

di DesignBuilder - Tutorial 2 DBv1.6.dsb - Layout - Tutorial 2, Building 1

Tutorial # 2 will still show you a . T =i

simplified version of the results. It _ [ O Y s Y A Y A |
will not display Relative Humidity -
values (RH) or air changes rates
(ac/h). The results that you will get
will also vary from those in the
tutorial as you are not using the
exact same design parameters.
(This is a result of changing default
values in DesignBuilder.)

14:00 16:00 18:00 20:00
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SIMULATION

Analyzing temperature profiles

4.

The first result you will get when [ > 2 _ TemporatweandHoatGains-Tutorial2 Buldngt
performing the first cooling design " €

calculation in Tutorial #2 will show
you free-floating temperatures as a
result of not having mechanical
cooling activated by default.

One can see that the “radiant
temperature” (red), “operative
temperature” (green) and “air
temperature” (blue) are well above
the “outside temperature” (dark
Blue).

The operative temperature is also
above the comfort temperature of
24°C-27°C recommended by
ASHRAE STD 55 and ISO 7730 at
50%RH when considering natural
ventilation.

14:00 16:00 1800 2000
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SIMULATION

Cooling Design Calculation

5 L.i DeSIgnBUIlder Tutorial 2 DBv1 PART 2 Cooling Design modfifications.dsb - HYAC - Tutorial 2, Building 1

Your screenshot after performing
the second cooling design
calculation with mechanical
cooling activated, should look
like this.

The tutorial wont display as
default the “System Energy”
demand, the “Relative Humidity”
nor the “Mechanical Vent + Nat
Vent + Infiltration (the sum of
outside air in ac/h).
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SIMULATION

.t DesignBuilder - Tutorial 2 DBv1 PART 2 Cooling Design modfifications.dsb - HVAC - Tutorial 2, Building 1

Analyzing Internal Gains

6.

If you go to the “Data” tab in the
“Display Options” menu, you can select
different data display options. In
“Internal Gains” you can find the
“Zone/Sys Sensible Cooling”

[ 1]
--l‘--------"=------

“Zone/Sys Sensible Cooling” is the 3 — N !_‘4 /|
sensible cooling effect on the zone of :

any air introduced into the zone
through the HVAC system. It includes
any “free cooling” due to introduction of
relatively cool outside air.

Cooling is always shown as a negative
heat gain in the results. It is best
thought as the energy required to cool-
down the space to the set temperature,
hence part of the zone heat balance. In
the “Internal Gains” graphs you can
see its correlation with solar gains or
other heat gain sources and their
schedules
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SIMULATION

Simulating a Summer Design Week
/.

At the “Building Level” go
to the “Simulations” to

perform the “real weather ® S baron _
data simulation”. @R |

it Calculation |

olthe simulation and the output

Simulatior, Period

days for the simulation, ar

When you first select “Sub-
hourly” weather data for a
Summer Design Week
calculation, you will be
prompted to download the
hourly from DesignBuilder X e
web site. o et ocuerts and 1 DatadDesigrB ulderWeather
Select “OK”. et

Builder web site.

Heating design | Cooling design
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SIMULATION

Simulating a Summer Design Week

8 & DesignBuilder - Tutorial 2 DBw1 PART 3 Simulation annual after selecting views.dsh - Layout - Tutorial 2, Building 1
| ]
File Go  Tools Help

Your screenshot after performing
the first real weather simulation
should look like this. It wont show
immediately any results.

You are currently viewing only
“Daily Data”, and since you
selected to perform just a “Sub-
hourly Data” calculation, there is
no “Daily” data to be displayed.
This is a useful feature to avoid
misinterpreting results.

In the “Data” menu, select “5-
Sub-hourly”. This will display the
calculations results. (The tutorial
switches to this version
automatically).

g design | Simulation
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SIMULATION

Simulating a Summer Design Week

9 ik DesignBuilder - Tuterial 2 DBv1 PART 3 Simulation annual after selecting views.dsb - Layout - Tutorial 2, Building 1
" File G Tooks  Help

Your screenshot after ‘En -
performing the first real d@4p>e B o= O BNt
weather simulation and =
selecting the “5-Sub-
hourly” data display should
look like this.

The tutorial wont display
as default the “Fuel”
demand (estimated period
consumption) nor “Total
Fresh Air” (the sum of
outside air in ac/h,
considering mech. vent,
nat. vent and infiltrations).
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SIMULATION

Performing an Annual Simulation

(0}

To perform the “Annual
Simulation” using “real weather

data, go the uupdate” |C0n. Then j . . imulation O lfi_o-rtl:“" s e st
select “annual simulation” and B} St prosees

Simulation P

ys Tor the simulation, or

select the Daily and the Monthly
and annual “Outputs Intervals for
Reporting”.

If you don’t select the Monthly
and annual interval, you wont be
able to display total annual or
monthly values under that option
in the “Display Options”. This
means that even if you calculated
the results of the 365 days of the
year, the program will not allow
you to display for example, the
Total Annual Fuel consumption.
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SIMULATION

Performing an Annual Simulation

11.

When selecting just the “Daily”
and “Monthly and Annual”
output intervals as reports, if
you where still in the “5-Sub-
hourly” display option you will
be prompt to re-simulate your
buiiding using “sub-hourly”
calculations. For this tutorial
select “NO”.

DesignBuilder

Loading data..
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SIMULATION

Results of an Annual Simulation
12.

If you are still in the “Open
Floor” level (as the Tutorial),
your screenshot after
performing the first real
weather simulation and
selecting the “1-Annual” data
display should look like this.

The tutorial wont display as
default the “Total Fresh Air”
(the sum of outside air in
ac/h, considering mech. vent,
nat. vent and infiltrations).
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SIMULATION

Results of an Annual Simulation

1 3 ok DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation annual after selecting views.dsb - Layout - Tutorial 2, Building 1

When at the “Building
level” and having selected
the “3-Daily” display
option, your screen should
look like this.

The tutorial will display
Instead of the “Total Fresh
Air” graph (the sum of
outside air in ac/h,

I Y Y DO |
e AT A
conS|der|ng mech. vent, !‘l‘!‘“‘!"} O .lmmmmm_mu.nwmmmmmm li[L'll

nat. vent and infiltrations) a =

“Total CO2” graph. Later
on this document you will
learn how to display the

CO2 information as well.
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RESULTS

In the preceding section you have used DesignBuilder to
calculate Heating and Cooling Design Loads and run Annual
Simulations using real weather data.

Now you will customize the display of results to allow you to
make a more comprehensive analysis and comparison of your
building’s energy performance. At the end of this sections you
will be able to:

@ Select which variables to include in the display of
Internal Gains, Fuel Breakdown, Comfort or Fuel
graphs, including CO2 values.
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RESULTS

Customizing results

| 4 i DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation final results. dsb - Layout - Tutorial 2, Building 1
n
File G Help

To display the annual CO2
Production for the building:

At the “Building Level”,
select “8-CO2 production”
data display.

You must know that the
“display data” options will
vary according to the
“level” in which your are:
Site, Building, or Block and
Zone.
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RESULTS

Customizing results

1 .' . 12 DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation final results.dsb - Layout - Tutorial 2, Building 1
Help

To display the annual CO2
Production for the building as SE4dr 2l F g
part of the Summary Graph: 2 :

At the “Building Level”, select
Data “1-All” data display, then go
to the “Detailed” tab in the
“Display Options”. Scroll down to
the ‘Heat Gain” category and
uncheck the “Total fresh air”
option. Keep scrolling down to
the “CO2" category and check
the “CO2 production” option.
Finally click in the “green check
icon”.

I A Temperstur= [ Radiant Tempersture I Operative Tempersture [ Outside Ory-Bulb Temperature

Task and Display L.. j m Heating design || Codling design | Simulation

Ready
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RESULTS

Customizing results

1 6 14 DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation final results.dsb - Layout - Tutorial 2, Building 1
n

To display the monthly energy
consumption by fuel, in a
customized graph layout, such
as a stack bar graph:

At the “Building Level”, select
Data “6-Fuel Breakdown” data
display, then go to the “Interval”
options in the “Display Options”
and select “2-Monthly.

Once the Monthly Fuel
Breakdown graph is displayed,
make a “right click” in the center
of the graph and select “Plotting
Method” > “Bar Stacked”.




Harvard Universily
Graduate School of Design

RESULTS

Customizing results

version: 9/30/2009

] 7 i utorial 2 DBv1 PART 3 Simulation final results.dsb - Layout - Tutorial 2, Building 1 =)
(]

To further customize
the display of results:

Meeting ream
Open Plan

Make a “right click”
the center of the graph
and select
“Customization
Dialog”

Fue Breakdown - Tutorial 2, Building !

| EnergyPlus Output 1 Jan - 31 Dec, Monthly Evaluation

[ DHW (2-Natural Gas) H f oom Electricity [ Lighting System Misc [l Heat Generation (Gas)
50000 Chiller (Electrici
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RESULTS

Customizing results | Fuel Breakdown - Tutorial 2, Building 1
1 8 . 50000

45000

You can export the
graph as an image by
making a “right click”
on the middle of the
graph > select “export”.

The graph allows you
to easily identify which
are the predominant
energy consumption
by end-uses along the f : ;
year and plan the , 200: Apr May
ECMs accordingly.
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RESULTS

Finally, to display “hourly” or “sub-hourly” values in a more
comprehensive manner you may adjust the numbers of days to be
display at a time.

We will carry out an example with a Summer Typical Week
calculation using the same model built in Tutorial #2. We will display
the Comfort Temperatures and the Internal Gains at the same time to
study the efficacy of the “external shading devices” implemented in
the reception area to control the solar radiation and improve internal
comfort conditions.

INE

(A “Summer Typical Week” is a week identified from the weather data file as being typical of the summer.
DesignBuilder uses EnergyPlus format hourly weather data to define external conditions during simulations.
Each location has a separate file describing the external temperature, solar radiation, atmospheric conditions
etc. for every hour of the year at that location. These hourly weather data sets are often 'typical' data derived
from hourly observations at a specific location by the National weather service or methodological office. You
can get Weather data for more than 2100 locations in EnergyPlus weather format from the U.S. Department

\of Energy website: http://www.eere.energy.gov/buildings/energyplus/cfm/weather_data.cfm

y,
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RESULTS

Customizing Results

19.

Go to the “update icon”,
then select “Summer typical
week” in the Simulation
Options and “Daily”,

Meeting room
Open Plan

“Hourly” and “Sub-hourly” ) z o
as the Output interval
Reporting.

Auto-Update
Thi

0 4000 41:00
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RESULTS

Customizing Results

L& DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation final results.dsb - Layout - Tutorial 2, Building 1, Reception, Zone 1 L.i]@m?ﬂ
File el e‘

20.

Go to the “Reception” zone,
then select “4-Hourly” as the
interval and “4-Internal
Gains” as the Data .

Internal G

Select “2” as the Days per
page to be displayed.

Y




Harvard Universily
Graduate School of Design version: 9/30/2009

RESULTS

Customizing Results

2 | i DesignBuilder - Tutorial 2 DBv1 PART 3 Simulation final results. dsb - Layout - Tutorial 2, Building 1, Reception, Zone 1

Go to the “Detailed” tab in the
“Display Options”. Scroll down to
the ‘Environmental” category
and check the “Air
Temperature”, “Radiant
Temperature” and the “Comfort
Temperature”. Finally click in the
“green check icon” and scroll to
display “Sunday and Monday”

Since the shading devices are
operating with the same
schedule as the occupants, by
comparing the internal comfort
temperatures on Sunday and
Monday we can easily evaluate
the efficacy of this ECM.
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CONCLUSION

This document provided a quick, non-exhaustive overview of
the building energy performance simulation capabilities
offered by DesignBuilder/EnergyPlus. Should you decide to
use this tool in the future consult the REFERENCE section

for further reading. Remember:

@ Itis your responsibility to learn the assumptions
and limitations of the programs you are using.

@ Preparing and running a simulation takes time.
Before rushing into doing a simulation you
should have a clear idea of how the simulations
results can help you resolve a specific design
guestion that you could not answer otherwise.
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CONCLUSION

Always consider that buildings are a complex
Integration of energy flows and systems
comprising not only the whole of building form
and fabric, but also plant and various other
environmental control systems.

All this variables will cause building energy
performance simulations, which add code and
algorithms to the equation making it even more
complex, subject to result in slightly different
values from case to case.
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NEXT STEP

8 In this document you have used DesignBuilder to calculate Heating
and Cooling Design Loads and run simulations using real weather
data. Now you should continue with document number 2, where you
will customize data templates and components for the project (glazing,
constructions, schedules, shading devices, etc). You will also modify
parameters to the interior environment and HVAC Systems.

“Modeling can be no more accurate than the assumptions that lie
behind both the proposed building and the baseline building model.
Even though the model performs complex calculations accurately on
this assumptions, the result will be misleading if the assumptions are
faulty.” Document #2 will work on some of the most critical assumptions
that will guide you when performing your first basic models.

To access it go to:
http://www.gsd.harvard.edu/research/gsdsquare/tutorials.html
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REFERENCES

DesignBuilder:

@ Consult the DesignBuilder Help Packages to get further information on
the program’s underlying calculation methods and how to explore the
Impact of key design aspects (e.g. natural ventilation) on building energy
performance simulations.

To access it: run DesignBuilder>>Help>>Content.

8 We strongly recommend you visit the “Knowledgebase” section in
DesignBuilder’s webpage which has answers to most common questions
about DB.

To access it go to: www.designbuilder.co.uk>Support>Knowledgebase.

8 Finally, DesignBuilder’s webpage has a very useful “DesignBuilder
Forum” where users post all sorts of questions which are usually
answered by DesignBuilder software developers. To access it go to:
www.designbuilder.co.uk>Support>DesignBuilder Forum.
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REFERENCES

EnergyPlus:

@ Developing a basic understanding of the EnergyPlus simulation
parameters and system data relationships is the key to reliable
simulations. A list of online resources for EnergyPlus is available under
http://www.eere.energy.gov/buildings/energyplus/.

@ You can find All EnergyPlus Technical Reports
at:http://gundog.lbl.gov/dirpubs/eplall.html.

@ All of the technical reports generated by the Simulation Research Group
are available at: http://gundog.lbl.gov/dirpubs/valid_ep.html

8 If you want to advance and connect further with the world of building
performance simulations you can subscribe to Energy Plus’ mailing list.
This mailing list is very active (+300 emails monthly) and normally deals
with very technical discussions. To subscribe go to:
http://tech.groups.yahoo.com/group/energyplus_support/
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